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Resumen del documento

Este documento ofrece una breve introduccion al proceso de crear, construir y depurar proyectos basados
en eZeeNet, utilizando el IDE de Atmel, AVR Studio [1], compilador WinAVR[2], [3] y hardware JTAGICE
mkll [4] en un PC bajo Microsoft® Windows™ 2000/XP.

En este tutorial se ensefia la forma de crear un pequefio proyecto que controle uno de los LEDs en la placa
desarrollo MeshBean de MeshNetic y depurarlo por medio de AVR Studio y el hardware JTAGICE mkll.

Convenciones utilizadas en el documento

Botones Los nombres de los botones de didalogo son representados en Courier: OK, Cancel
Comandos Los items son representados en Courier y mostrados en el orden en que deben ser

de menu seleccionados: File ->Open

Atajos de Muchos atajos deben ser presionadas simultdneamente en el orden en que se muestran:
teclado F7, Ctrl-Shift-F5

Cadigo Los fragmentos de cédigo se muestran en texto coloreado:

fuente /***********************************************

User's entry.

*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*************************/

void fw userEntry (FW ResetReason t resetReason)

Intencién del documento

Este documento esta dirigido a los desarrolladores que quieran familiarizarse con la creacién de
aplicaciones mediante la pila MeshNetics eZeeNet ZigBee.

Documentos relacionados

[1] AVR Studio. User Guide. Available in HTML Help with the product.
[2] WinAVR User Manual / Ed. by Eric B. Weddington
[3] Using the GNU Compiler Collection/ By Richard M. Stallman and the GCC Developer Community

[4] JTAGICE mkIl Quick Start Guide http://www.atmel.com/dyn/resources/prod documents/doc2562.pdf

[5] ZigBit™ Development Kit. User’s Guide. MeshNetics Doc. S-ZDK-451
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Prerrequisitos

Aseglrese de que dispone de las ultimas versiones de AVR Studio/Service Pack
(http://atmel.com/dyn/products/tools_card.asp?family_id=607&family_name=AVR+8%2DBit+RISC+&tool
_id=2725) y WinAVR (http://winavr.sourceforge.net) instaladas en su PC.

También necesitara una tarjeta MeshBean y un dispositivo Atmel JTAGICE.

Creando un nuevo proyecto en AVR Studio

1. Inicie AVR Studio. Aparecerd en pantalla el asistente de proyectos (ver Figura 1).

Welcome bo AYE Studio 4
@ Few Praject ‘ Open

Recent projects | t odified |

'ﬁ C:hedkh. . ASampledpclicationhRenoteContralh111.aps 01-0ct-2007 18:27:54

‘ﬁ C:hedkh . MWaPS ampledpplizationsBlink \blink. aps 24-40-2007 [2:03:21

y V-.; C:hedkh. . APowerbd anagement' Powerhd anage.aps 27-tug-2007 184329

'ﬁ C:hedkh. ASimpleD at=E xchange. 2ps 14-Sep-2007 13:31:00

‘ﬁ C:hadkh speerZpeer_r2\pearZpeer. aps | 2-5ep-2007 [6:14:41

'ﬁ C:hedkh. . A5 ampledpolicationhSerzorR ead'Light. ap: 12-5ep-2007 18:23:27

‘g C:hadleh.. Mpingpong_r2hpingpong.aps 12 Sep 2007 16:12:28

'ﬁ C:hedkh. . Mowpower_13hcoordinatar. aps 0B-Apr-2007 21:4%:37

ﬁ Ak SBE2NMWAPE Sarpled pplicatinnh aznnlassnml NA-Fea-2N07 12-35-R0

'ﬁ C:hedkh. . ARemateControlhFemoteCaontrol. aps 28-A0g-2007 15:43:33

Werd 13557 [ Shoa dislog at starturs

< Bany | et = I Firizh Cancel Help

Figura 1: Ventana del Asistente de Proyectos

2. Presione el botéon New Project.Sino aparece el asistente, seleccione Project ->
New project del menu principal de AVR Studio.

3. Enlaventana que aparece a continuacion (ver Figura 2), seleccione AVR GCC en Project
type, e introduzca el nombre del proyecto en Project name. Para crear
automaticamente un archivo fuente inicial, seleccione la casilla Create initial file
e introduzca un nombre para el archivo (sin extension) en ITnitial file. Paracrearuna
carpeta con el nombre del proyecto seleccione la casilla Create folder. Finalmente,
presione el boton El juntoa Location vy seleccione un directorio para su proyecto.

Presione Next >> para continuar a la siguiente pantalla.
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Welcome to AYR Studio 4
— Create new projest
Projec: wpe: Project name;
& el AVR Azsembler IDebugTest
“E4 AR GOC
¥ Createinitial file W Create folder
Intial file:
ILJEI::ugI ezt .C
Location:
IE:'&zdkHreIease'\.&F‘l'ﬁS amplzapplicaticn’,
Werd 13557
<< Back Mest = Finizh Carcel Help

Figura 2: Creando un nuevo proyecto

4. En la siguiente pantalla que aparece (ver Figura 3), seleccione JTAGICE mkII de Debug
platform yATmegal281 deDevice.Pulse Finish para cerrar el asistente.

Welcome to AYR Studio 4

— Selecl debuyg plationn arnd device

['ebug alatform: Device:
AWE Dragon ATA0USEE4T ;l
AWE Simulator ATA0USES2
AR Sirnulato Y2 [preview] A mega 23 J
|[CEZ200 A mega” 280
ICE 4L A nega” 281
ICERD A moga B
JTAG ICE ATmega 62
ITAGICE mikll A" mega” B4P
A neya” B0
A" mega” BEF
A" mega” GO ;I

Part: I.ﬁxutc\ "I [ Opan platfarm options

<< Back | et =

Finizh

LCancel

Help

Figura 3: Seleccionando plataforma de depuracién y dispositivo

¢/ Doce de Octubre 38 - 28009 Madrid e Telf.: 91 504 02 01 * Fax: 91 504 00 69
e-mail: info@nextfor.com e http://www.nextfor.com

Pagina 4 de 11



Mes

[Ehwmum Creando, construyendo y depuran(.io aplicaciones P
eZeeNet en AVR Studio “Next For

Ajustando las opciones del proyecto

La coleccidon de herramientas WinAVR requiere el uso del llamado makefile, un archivo de texto plano que
contiene todas las opciones de proyecto, nombres de librerias/fuentes/objetivos y todo lo necesario para
construir la imagen objetivo. Esto resulta un tanto mas dificil que el uso de GUI, pero ofrece un mayor
control sobre el proceso de construccion.

Para usar makefile en AVR Studio, vayaa Project ->Configuration enelmenuy seleccione la
casilaUse external makefile.Pulse el botén Ejunto al cuadro de texto y seleccione su
makefile (normalmente localizado en la misma carpeta que el proyecto AVR Studio). Pulse OK para cerrar
la ventana.

Aqui tiene un ejemplo de makefile que puede utilizar como referencia en proyectos futuros:

S
# Makefile for the project DebugTest

FHAFH AR S
## General Flags

PROJECT = DebugTest

MCU = atmegal28l

TARGET = DebugTest.elf

CC = avr—-gcc.exe

## Options common to compile, link and assembly rules
COMMON = -mmcu=$ (MCU)

## Compile options common for all C compilation units.
CFLAGS = $ (COMMON)

CFLAGS += -Wall -gdwarf-2 -0Os -std=gnu99 -fsigned-char -fpack-
struct

CFLAGS += -MD -MP -MT $ (*F).o -MF dep/$(QF).d
## Assembly specific flags

ASMFLAGS = $ (COMMON)

ASMFLAGS += $ (CFLAGS)

ASMFLAGS += -x assembler-with-cpp -Wa,-gdwarf2
## Linker flags

LDFLAGS = $ (COMMON)

LDFLAGS += -Wl,-Map=DebugTest.map

## Intel Hex file production flags

#HEX FLASH FLAGS = -R .eeprom

HEX EEPROM FLAGS = -j .eeprom

HEX EEPROM FLAGS += --set-section-flags=.eeprom="alloc,load"
HEX EEPROM FLAGS += --change-section-lma .eeprom=0

## Path to Stack, StackSupport, HAL, TOSLib.

SUPPORT DIR = ../..

#SUPPORT DIR=$ (wildcard ../../../WSN)$ (wildcard
./../../trunk/src/WSN)

## Modules directories paths.

APP DIR =

STACK DIR = $(SUPPORT_DIR)/StaCk
STACK_SUPPORT DIR = $(SUPPORT_DIR)/StaCkSupport
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TOSLIB DIR = $(SUPPORT DIR)/TOSLib

HAL DIR = $(SUPPORT7DIR)/HAL/HAL7R6
FRAMEWORK DIR = $(SUPPORT_DIR)/FrameWOrk
## Include Directories.

INCLUDES = —I"$(STACK_DIR)/inClude" \
—I"$(TOSLIBiDIR)/inClude" \

-I"S (HAL DIR)/base/include" \

-I"S (HAL DIR)/eZeeNet/include" \

-I"S (HAL DIR)/meshBean2/include" \

-I"$ (STACK SUPPORT DIR)/include" \
-I"$(STACK SUPPORT DIR)/include/stack" \
—I"$(FRAMEWORK_DIR)/include"

## Library Directories

LIBDIRS = -L"$ (HAL DIR)/1ib" \
—L"$(TOSLIB_DIR)/lib" \
—L"$(FRAMEWORK7DIR)/lib" \

-L"$ (STACK SUPPORT DIR)/lib"

## Libraries

LIBS = -ltos \
-lmeshBean2 \
-1FW \

-172igBitInt \

-lstackSupport \

-lc

SRC = $(APP DIR)/DebugTest.c \

$ (STACK SUPPORT DIR)/src/ConfigServer.c \

## Objects explicitly added by the user
LINKONLYOBJECTS = $(STACK_DIR)/lib/NWKMACLibA.O \
$(STACKiDIR)/lib/APLLibA.o \
$(HAL7DIR)/lib/wdtinit.o

## Build

all: clean $(TARGET) DebugTest.hex DebugTest.eep size
## Compile

DebugTest.o: DebugTest.c

$(CC) $(INCLUDES) $(CFLAGS) -c $<

ConfigServer.o: ../../StackSupport/src/ConfigServer.c
S (CC) $(INCLUDES) $(CFLAGS) -c $<
## Build

all: clean $(TARGET) $(PROJECT) .srec $ (PROJECT) .hex
S (PROJECT) .eep size

##Link
S (TARGET) :

$(CC) $(CFLAGS) $(INCLUDES) $(SRC) $(LINKONLYOBJECTS) -o
$ (TARGET) $(LIBDIRS) $(LIBS)

%$.srec: S (TARGET)
avr-objcopy -O srec $(HEX FLASH FLAGS) $< $@
%.hex: $(TARGET)
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avr-objcopy -O ihex $ (HEX FLASH FLAGS) S$< $@
%.eep: $(TARGET)

avr-objcopy $ (HEX EEPROM FLAGS) -0 ihex $< $@
%.lss: S (TARGET)

avr-objdump -h -S $< > $@

size: S${TARGET}

@echo

Qavr-size -C --mcu=${MCU} S$S{TARGET}

## Clean target

.PHONY: clean

clean:

-rm -rf $(OBJECTS) DebugTest.elf dep/* DebugTest.hex
DebugTest.eep DebugTest.srec

## Other dependencies
-include $(shell mkdir dep 2>/dev/null) $(wildcard dep/*)

Escribiendo el cadigo fuente

Puede escribir su codigo fuente en AVR Studio o mediante cualquier editor de texto apropiado. La
estructura general del archivo es la misma que la que usaria en cualquier otro proyecto basado en C
(cabeceras, definiciones, codigo). A continuacion se muestra el cddigo que se va a usar en este tutorial:

/*******************************************************

LED Blinking Implementation Project: C source
*******************************************************/
#include "framework.h"

#include "gpio.h"

#include "apptimer.h"

#define LED GPIO 0 // Pin connected to LED.

// Functions' declarations.

void mainLoop(); // Main loop.

void timerFired(); // Blink timer handler.

/*******************************************************

User's entry.
*******************************************************/
void fw userEntry(FW ResetReason t resetReason)
{

// Initialize the pin connected to the LED.

gpio setConfig(LED, GPIO OUTPUT) ;

// Open and start blink timer.

{

int handle;

handle = appTimer open (timerFired);
appTimer start (handle, TIMER REPEAT MODE, 1000);
}

// Start main loop.

fw_setUserLoop (20, mainLoop) ;

}
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Mesh

/*******************************************************

Main loop.
*******************************************************/
void mainLoop ()

// Addtional user's activities.

}

/~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<*********************************

Blink timer handler.
*******************************************************/
void timerFired()

{

static bool on = 0;

gpio_setState (LED, on);

on =on ? 0 : 1; // Toggle.

}

// eof DebugTest.c

Una vez haya terminado de escribir su cddigo, puede construir la imagen ejecutable seleccionando
Build ->Build del menu o presionando F7. Pude hacer uso también del comando Rebuild
all en proyectos largos para asegurar que se compilan todos los cambios del cédigo. La ventana Build
(en la parte inferior de la pantalla) mostrara la salida del compilador avr-gcc (ver Figura 4).
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s Init ze the pin comnected to the IED E\‘:'PIJHTE
@ aric_sctConiig(LED, GEIO_CUTFUT)H =
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| | »
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Figura 4: Construyendo la imagen

Si el cédigo no contiene errores, se generard un archivo DebugTest.elf en la misma carpeta en la que se
encuentra los archivos del proyecto (a menos que especifique un directorio de salida diferente en el
makefile). Esta es la imagen ejecutable que utilizara el depurador.

Depurando la imagen

Puede ahora comenzar la sesion de depuracidn para la imagen que acaba de construir. Primero, conecte
su MeshBean al dispositivo JTAGICE y alimente los dispositivos (pueden ser alimentados por USB).

Para probar las caracteristicas de depuracién de AVR Studio, sitie un breakpoint (pulse F9) en cualquier
linea de cddigo de la que esté seguro que va a ser ejecutada. En este caso, se hara en la funcion
timerFired(), que va a ser llamada periédicamente para el parpadeo de los LEDs de la placa MeshBeans.

Ahora, seleccione Debug ->Start debugging de laaplicacién AVR Studio o pulse Ctrl-Alt-Shift-
F5. Este comando se encuentra disponible Unicamente después de ejecutar el comando Build. Si
reinicia AVR Studio, debera construir de nuevo la imagen. AVR Studio comenzara a programar el
dispositivo con la imagen construida, indicando el progreso con la barra de progreso en la parte inferior de
la ventana. Después de que la programacion esté completa, saltard la siguiente ventana (ver Figura 5).
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K )

“Next For

lized Data

Py

This object file indicates initialized EEPRCM data, Do vou wank ko load this data?

Cancel |

Figura 5: Confirmacion de carga de datos a la EEPROM

eZeeNet utiliza una porcidn de la EEPROM para almacenar sus pardmetros. Pulse en el boton OK para

cont

inuar.

En algunas ocasiones, AVR Studio interrumpira su ejecucién y mostrard la ventana de desensamblado con

contenidos invélidos (ver Figura 6).
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Figura 6: Ventana de desensamblado

Cierre esta ventana y presione F5 para continuar la ejecucién.
primer breakpoint del cédigo (ver Figura 7).

AVR Studio pausara la ejecucion en el
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Figura 7: Depurando

Enelmeni View, puede seleccionar adicionales ventanas de depuracién: procesador, E/S,
desensamblador, vigilancia de variables, memoria, registros, etc. Pulsando con el botén derecho del ratén
en el editor de codigo, podra disponer también de unas pocas opciones de depuracién, como afiadir y
eliminar brakpoints y expresiones de vigilancia.

Puede continuar con la ejecucion en cualquier momento pulsando F5. Si pulsa Shift-F5, reiniciara la sesion
de depuracion.

Para detener el depurador, seleccione Debug -> Stop debugging del menu o pulse Ctrl-Shift-F5.
Este comando esta sélo disponible en modo stop, es decir, debera pausar primero la ejecucion y después
detenerlo completamente.
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